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CamTrap Pro Overview 
CamTrap Pro can add tags to files and produce a map-based or text report of animals found in 
collections of camera trap images as detection events over a period of days or weeks. Detection 
events occur when an animal appears in a single image, or a sequence of images where the time 
between successive images does not exceed a specified duration (commonly 10 minutes). Detection of 
animals can be performed by visual inspection, simple time and pixel-based algorithms or machine 
vision models. Results from classifiers using the generic Megadetector mode (such as EcoAssist) can be 
loaded as JSON files. Classification results can be applied without the host computer needing an Nvidia 
GPU. Species-specific models can be used by EcoAssist and tags automatically generated from 
classification results. 

Installing and Running CamTrap Pro 
CamTrap Pro can be downloaded from 
https://captionpro.com.au:444/AlekaConsulting/index.php/camtrap-pro-download-form/  
CamTrap Pro processes only JPEG format image files taken from camera traps. It adds Windows tags to 
files, optionally from a fixed range of values, and summary and occurrence reports of tagged files can 
be generated and exported. Images containing animal images are detected and flagged using JSON 
files generated by machine learning programs such as EcoAssist. These images may constitute a very 
small proportion of images recorded by camera traps. Tagging of images containing animals with the 
animal identity can be performed visually or using a species-specific image classifier, and can be 
applied directly to recorded images, or to the subset containing animals as detected via machine 
learning using the Megadetector model. A tutorial video for CamTrap Pro operation can be viewed 
here. 

  

https://captionpro.com.au:444/AlekaConsulting/index.php/camtrap-pro-download-form/
file:///C:/Users/simon/source/repos/Collateral/at%20https:/youtu.be/JDvKaprvtfs
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Camera Trap Data 
Camera trap data comprises a large number of digital image (and sometimes video) files collected by 
cameras triggered by a relative change in the levels of infra-red radiation reaching a sensor from two 
halves of an image field. Changes may be produced by an animal entering the field of view of the 
sensor, or by movement of objects or shadows within the sensor field. An infra-red flash is used to 
record monochrome images from triggerings occurring at night. When triggered, the camera may 
record single images, a sequence of images or a short video when triggered. Data is commonly stored 
on a removable SD card as JPEG format images, and traps may be active for many days between data 
collections. The date and time recorded by the camera (and possibly other local information) is shown 
in a bar above or below the image. Dates and times may not correspond to the actual time of image 
collection, as the camera local time may not be correctly set. Image file names usually contain a 
number which increases sequentially. An example of an image obtained with such a camera during 
daytime is shown below: 

 
Figure 1 Daytime Camera Trap image of a rabbit 

An image recorded at night is as shown below: 

 
Figure 2 Night-time Camera Trap Image of a Cat 

Although the appearance or movement of animals occupying a significant proportion of the sensor 
field will trigger the camera, movements of leaves, grass, camera position or changes in solar 
illumination will also trigger the camera, resulting in the images recorded not showing any animals. 
These non-animal triggerings may constitute up to 95% of the images recorded. Triggerings from the 
presence of animals which are not of primary interest (such as foxes) may also comprise a significant 
proportion of images recorded. Changes in the physical environment of the sensor field (such as 
removing grass and branches affected by wind) may help reduce non-animal triggerings, but may 
result in animals avoiding the area. 
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If a bait (which may be peanut butter, sesame oil or carrion) is included within the camera field of 
view, animals such as foxes or crows may spend considerable time moving around in order to eat it, 
resulting in large numbers of images of the same animal appearing in sequential images, closely 
spaced in time. The images below show a fox circling a bait. 

 
Figure 3 Fox circling a bait 

Non-baited traps in highly modified environments lacking extensive vegetation cover (such as urban 
areas) have a low rate of non-animal triggering. Datasets may cover many months (presumably with 
periodic battery changes) and record numerous short detections as animals move across the camera 
field of view. Longer detections occur, but are rarer. A section of such a dataset is shown below: 

 
Figure 4 9-day section of a 1-year Count vs Time Profile of an Urban, Non-baited Dataset 

Automated methods of detecting the presence of animals in an image using machine learning have 
been developed, notably MegaDetector, which can be run from the EcoAssist application. EcoAssist 
requires a powerful local machine with at least 16 Bytes of RAM. An Nvidia Graphics Processing Unit 
(GPU) greatly speeds processing. EcoAssist can use MegaDetector in generic mode, where it detects 
any animal, or it can be trained to identify particular species. Training a detector requires very large 
numbers of training images and is prohibitively slow on machines which do not have an Nvidia GPU, 
but application of detectors is possible on such machines. 

https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://petervanlunteren.github.io/EcoAssist/
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Machine learning facilities such as Megadetector are highly effective for common animals, but require 
substantial computing resources. By contrast, non-fatigued human vision is fast and extremely 
accurate in detecting animals, but the task of detecting animals in the thousands of images taken even 
by a single camera is daunting, and some projects may use dozens of cameras. CamTrap Pro has been 
designed to facilitate inspection of large numbers of camera trap images and tagging of images in 
which animals appear using the Windows Tags field to store the species names of animals appearing. 
Some simple detection algorithms which do not require training are provided, as well as an interface 
to results obtained from Megadetector or a custom classifier. Megadetector is used only to detect the 
presence of animals. Tagging to indicate which species are present can done visually or using a custom 
classifier. The 8000-image, 10-month dataset shown in part in Figure 4 from a non-baited trap in a 
highly modified area with little vegetation records animal detections in most images, but only a few 
detections each day. Such datasets are best analysed using a species-specific classifier to identify the 
species of detected animals. 
 

CamTrap Pro Data Requirements and Processing 
In order to use CamTrap Pro for camera trap analysis, images in JPEG format should be within a folder 
structure on storage which is not read-only, as numerous temporary files are created in the image 
data folder. If the selected folder is read-only, no files are loaded. For multi-camera data sets, the 
images should be stored 1 or 2 levels below a folder whose name represents the camera identity. If 
individual images have EXIF Date or Windows Modified Date metadata the images can be sorted in 
time order. The image Modified date may reflect the time of processing rather than the time of image 
collection, but this date can be reset within CamTrap Pro if required. 
 
Camera trap data from many cameras collected over multiple time periods may be organised by 
grouping images from the same camera, or the same time period or both. To make best use of the 
time profile capability of CamTrap Pro, data should be organised by camera (or by site if different 
cameras are used at the same site. Shortcuts to folder can be used to do this without changing the 
organisation of the original data. The images should be in a folder structure as shown below. 

 
 
 
Folders with dotted borders are optional, but Image Group folders are commonly present. Image 
Group folders contain up to a fixed number of files (either 100, 1000, or 10000) with the folder name 
containing a sequential number starting at 100 in the manner of digital cameras. When additional 
images are added and the number of files in the Image Group exceeds its limit, a new folder is created 

Image Group 
(images) 

Image Group 
(Images) 

Camera  
(may contain images) 

 

Camera Group 
 

Epoch 

Figure 5 Folder Tree Structure 
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and file sequence numbers restart. Details of the folder structure should be set in the Options-
>General tab. 
 
Images may be contained directly in camera folders, and there may be groups of cameras at the same 
site (identified by the Camera Group folder) to facilitate detection of individual animals by their body 
or face markings. Each camera folder should have a unique name. The Epoch folder should contain 
images collected over a period of time. The name of the Epoch folder is used for correcting Modified 
date/time values. 
 
CamTrap Pro will operate if this structure is not present, but functionality such as Camera Info or time 
setting using Epochs will not work. 
 
Some examples of folder structures are shown below: 

  
 
Figure 6 Example of multiple camera folder trees using parent (left) and grandparent (right) structures. 

The parent (or grandparent) folder of the camera folder is the epoch, or time period over which all the 
images below it were recorded. An example is shown below: 

 
Figure 7 Folder structure showing epoch, camera and image group folders 

Two epochs (Week 1 27 Nov- 4 Dec 2022 and Week 2 4-11 Dec 2022) are shown, with 4 camera 
folders during the first epoch and 2 in the second. Data can be processed either by individual camera 
or collectively. 
 
A database storing tag occurrence data (TagDB_EpochName_CameraName_.vdb5) is created in in the 
folder above the folder containing the first image file. EpochName and CameraName are as defined in 
Options. This database should not be deleted. 
 
Progress bars are shown for long-running operations, but the estimated run duration may not be 
accurate. Storage speeds strongly affect processing times, so any external storage should have a high 
access speed. Solid state drives generally have faster access speeds than magnetic drives. 
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Reviewing Camera Trap Data with CamTrap Pro 
Camera traps may be used in a wide range of purposes including feral animal monitoring, species 
monitoring, density estimation, and game detection. They may be located in highly accessible areas, 
where scenes may frequently include vehicles and humans, or off-track where moving objects are 
much more likely to be animals (or birds). Baits (peanut butter, sesame oil or carrion) may be used to 
attract animals into the camera scene. Multiple cameras are usually deployed. 
 
An indicator of the presence of animals in a baited camera trap is to examine the cumulative time 
profile of all the images. As animals often spend some time moving around the bait, the camera is 
triggered multiple times with a very short interval between images. Profiles of image count as a 
function of time and the same profile with visually assigned animal detections marked in red (shown 
by checking Analysis->ShowTagged) is shown below: 

 

 
Figure 8 Image count vs time over 7 days (top) with one or more animal detections shown in red (bottom) 

It may be seen that animal detections are associated with a rapid increase in image count over a short 
period appearing as a vertical step, and that almost all camera triggerings are due to the presence of 
an animal.  
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A plot for a different data set over a similar period with mainly false triggerings, and animal detections 
shown in red, is shown below:  

 
Figure 9 Image count vs time over 7 days with a single animal detection shown in red.  

This data set (from a baited camera) only recorded a single animal over 8 images out of 5000 collected 
over a 7-day period. The animal was not attracted to the bait. Most triggerings were from moving 
vegetation or changing shadow areas. Triggerings were less frequent at night, giving rise to the 
stepped profile. 
 
A data set from a single day using a non-baited trap is shown below: 

 
Figure 10 Image count vs time over a single day, with animal detections shown in red.  

As non-baited traps only record animals passing, detections are less distinctive amid false triggerings 
from moving vegetation or shadows. Few images of animals are recorded. The step shown at 0900 hrs 
is from multiple triggerings when an animal passed very close to the camera, but the incomplete and 
unfocussed view meant that the animal could not be identified. 

Data Required from Processing 
Data required from a camera trap data set is the species of animal detected, and sometimes the 
frequency of detection, or the identity of the animal. This data can be obtained by inspection of 
individual images using built-in computer facilities, and then adding metadata (usually as tags) to 
indicate the presence of an animal in an image. This process is very labour-intensive and without a 
large and competent volunteer labour force it is not an option, especially when a single camera may 
record thousands of images in a single day. Automated methods using machine learning (such as 
Megadetector) provide an alternative. The implementation of Megadetector in CamTrap Pro only 
identifies images containing animals – species labelling must be done manually, or a species-specific 
classifier can be used. 
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Using CamTrap Pro to Examine Camera Trap Data 
Where file Modified Date is the same as Date Taken, processing will be faster if File Order in Folders is 
set to Modified Date or Folder->Modified. Pre-set text strings should be created to include the names 
of all animals expected to be detected. If individual animals are to be identified, specific names should 
be added (eg Goanna Rex). Unexpected animals may be added to pre-sets during inspection. 

Loading Data 
Camera trap images are usually contained in one or more folders per camera or site with filenames 
which include a sequence number in the manner of images from digital cameras. There may be 
multiple folders for the same camera corresponding to different time periods or different locations. 
Camera folders are usually the parent or grandparent folder of the image files. The time period over 
which images below a folder is known as the epoch and is usually the folder containing the camera 
folders. Either of these can be selected in the Options screen. The image filenames usually contain a 
sequence number, and may include a constant string or a representation of the date on which the 
image was taken. The date on which the image was taken is often stored in one or more of the EXIF 
date fields (Date/Time, Date/TimeOriginal, and Date/TimeDigitized). One of these dates is shown in 
Windows File Explorer as the image date. The file Modified date will be the same as this date unless 
the file has been processed in some way. Any folders containing images to be processed should not 
include the string .jpeg or .jpg in their name, as this may cause external programs such as EcoAssist to 
crash. If file Modified dates are to be changed, files should not be read-only. 
 
The File menu of CamTrap Pro is shown below: 

 
Figure 11 File Menu 

After Opening or Re-opening a folder, a screen is shown allowing a subset of camera folders to be 
processed where there is more than one camera folder below the selected folder: 

 
Figure 12 Multiple camera folder screen 

Clicking Cancel aborts the loading process and clicking Yes allows camera folders to be selected from 
the screen below: 

 

Figure 13 Camera Data Selection Screen 
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The File count in each camera folder is shown in brackets after the name. Either the Parent of 
Grandparent of the image files can be selected as well as the camera name. Data may be grouped by 
epoch of recording and then by camera or site. A site may use the same camera for a number of 
epochs, or different cameras. If data is grouped by epochs, a view of the data by camera can be 
created via the Re-order button in Pre/Post Processing screen.  

Options – General  
The Options tabs General and Advanced are shown below via File->Options: 

  
Figure 14 Options – General Tab 

File Order in Folders 
File Order in folders specifies the ordering of files within the selected folder as Modified Date or 
Folder->Modified (default). The default options order files by Modified date within camera folders. 
Modified date may be changed by checking the Change Modified Date on Load checkbox, using 
options specified in the Change Modified Date Options box.  

Change Modified Date on Load 
Changing the Modified date to reflect the actual date and time at which the image was recorded is 
useful if the count vs time profile is used and is required if highlighting is to be performed using the 
Changes or Sequences options. It is not required if machine learning algorithms are used to detect 
animals in images and only the number of images in which animals appear is required. 
 
If the checkbox is checked, one of the following options can be selected. After loading with the 
checkbox checked, it is automatically unchecked. 

 

Option Description 

Add Increment 
from Date/Time 

Sets the Modified Date to the specified date plus the time difference 
between the current image Modified date and the first image loaded. If 
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there is a gap between the date of the first image and the start of the 
recording epoch, images before the start of the recording epoch should 
be deleted via the Check Times Pre-Processing screen. This option can 
correct for camera time not being set to the time at which the camera 
was first triggered as it preserves the time interval between images. 
Date Formats can be like any of the following: 
01/10/2022 22:35 
01/10/2022 10:35 PM 
1/10/2022 7:35 AM 
1 Oct 2022 10:35 PM 
Oct 1, 2022 10:35 PM 
This option is disabled if Use Epochs is checked. 

Use Epoch Check to use a different specified date if the Epoch folder matches the 
Epoch name entered via Set Epoch and the Modified date is earlier 
than the Start Date of the Epoch or later than the End Date. Allowable 
date formats are as above. Epoch names and starting dates are 
specified by clicking Set Epochs. 

Shift Add or subtract a number of seconds from the existing Modified Date. 
Calculate button shows web site for calculating interval between 2 
times. 

Date Taken/OCR Set Modified Date to EXIF or Reconyx Hyperfire directory metadata 
fields Date/Time, Date/Time Original or Date/Time Digitized, or File 
Modified Date in the File metadata directory. If neither of the 
preceding metadata fields are found. If this does not exist or is invalid, 
use OCR on a region of the image as described below. 

Date Taken Set Modified Date to EXIF or Reconyx Hyperfire metadata directory 
fields Date/Time, Date/Time Original or Date/Time Digitized, or File 
Modified Date in the File metadata directory. If this does not exist or is 
invalid, the Modified date is unchanged. If further change to the time is 
required, the Shift option can be used after Date Taken. 

Set from OCR on 
Image Region 

Get Date from OCR on region of image where date is shown. The 
region is selected using the Set Region button. Failed date extractions 
are logged in file SetDateFromImageFails.txt which is created in the 
loaded folder.  

 
If this option is checked after files have been loaded in Modified Date order, the option to re-load the 
files to reflect the changed order is shown. The checkbox is unchecked after loading. 
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Set Region 
Clicking this button allows selection of a file within which the date is shown as below: 

 
Figure 15 Screen from which to select date region 

Clicking and dragging and releasing shows a red box, which should contain the date region. The date 
region should allow for the increase in length caused by multiple digit values in the date string and 
should generally include the region up to the first non-date character as shown above. The top and 
bottom of the region include all of the data digits. 
 
The colour of the background (black or white) should be specified, and the format of the year, month 
and day parts of the date string. 
 
Clicking OK transfers the pixel dimensions of the date area to the Options screen. These values can 
then be edited. The Top LH Y value should not be less than zero. 

Set Epochs 
This screen is accessed via the Set Epochs button. It allows definition of the epoch name and range of 
allowable date/times, either by entering rows one at a time or pasting epoch with each epoch name 
and on a new line with name, start date and start date limit separated by a tab character. The Start 
Date Limit must be equal to or after the Start Date. If the Modified date/time of a file loaded is outside 
this range, Modified dates are shifted to use the Start Date specified plus the difference between the 
Modified date of the first file and the Modified date of the current file. This facility is used to make the 
Modified dates of the loaded files correspond to the date at which the photo was actually taken, 
which may not be the time recorded in the Date Taken metadata. 
  
The Epoch name must exactly match the name of the Epoch folder. If the Epoch folder name is not 
found, the option to continue leaving Modified date unchanged or to stop loading is presented. If the 
recorded Modified date is before Start Date or after the End Date, then this date is used for the first 
image and time differences are added onto this. Epoch names, start or end dates can be added, 
removed or edited. Allowable date formats are as defined in Change Modified Date on Load. Update 
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should be clicked before closing the screen if data is not added by pasting. The Epoch name is the 
name of the folder 1 or 2 levels above the camera folder as defined by Epoch Levels Above Camera. 

 
Figure 16 Epoch name, start date and start date limit definition 

 
 

Detection and Name As Tag 

 
Figure 17 Detection Category Grid 

The Detection grid is used to show detection category names, the number of files with detections in 
that category (after using Machine Learning) and whether highlight detections with the category 
within the range specified in Confidence Range are used, and whether category names are applied as 
tags. The Megadetector classifier uses IDs 1,2 and 3 for animals, humans and vehicles respectively. 
Classifiers which identify particular species will have their own numbering scheme as shown above, 
which is defined in the detection_categories node of the JSON file. The category name is shown in the 
2nd column (CategoryName), the number of detections (Count) in the category in the 3rd column, 
whether to highlight detections with that category in the 4th column (Use), and the option to use the 
category name as a tag is set with a checkbox in the 5th column (NameAsTag). The Use checkbox above 
the grid sets or clears the Use parameter for all categories, and the Name as Tag checkbox does the 
same for the NameAsTag parameter. 
 
The Set To Default button restores the default categories of animal, vehicle and person used by 
Megadetector. Load Categories loads the categories defined in a JSON file  
 
The Count column is empty before any JSON file is loaded. After one is loaded, the number of 
detections with a particular category in the file are shown. 
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Filter 

 

Highlights Only 
If this is checked, only files which have had highlights created will be loaded. If highlighting from 
Megadetector is used, these are files where there has been a detection with a confidence between the 
upper and lower bounds specified. The highlight categories shown in the combo box to the right will 
be shown. “All” includes all highlight categories. Other single categories can be selected from the 
dropdown list, which shows the category name followed by its numeric code. 

Non-Highlights Only 
If this is checked, only files which have not had highlights created will be loaded. These will generally 
not contain images of animals, but will contain images of animals where the detection confidence is 
outside the range specified. 

Below Threshold Only 
If this is checked, only files with at least one detection below the lower threshold will be loaded. If any 
animals of interest are shown, the lower bound of the detection confidence range should be 
decreased. However, the number of false detections will increase. 

Date Range (Days) 
If this is checked, only files with Modified dates between From and To (in whole days) are loaded. The 
time part of any date/time entered is ignored. If To is empty, it is assumed to be 1 day after the From 
date. If specified, the To Date must be after the From Date. Examples of acceptable date formats are 
shown below: 
01/10/2022 
1/10/2022 
1 Oct 2022 
Oct 1, 2022 

None 
This option loads all files in the selected folder. 

Skip Files Less than N secs Apart 
This option skips loading for files whose Modified date is equal to or less than a specified number of 
seconds after its predecessor. This option can greatly reduce the number of files loaded, as there a 
generally a number of images showing the animal recorded as the animal moves within the camera 
detection area. The value for image count and duration will be affected, but not the number of 
detection events, which occur when an animal appears in one or more images separated by less than 
10 minutes. The reduced data set can be copied using Copy Loaded and then processed using machine 
learning. The reduced number of files will speed processing. As detection events are used to estimate 
species abundance, using this filter setting will not affect abundance estimates. 
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Load Every Nth File 
This option reduces the number of files loaded by decimation using the selected factor and is useful 
for loading a sample of file to check start and end times for camera data for large data sets. 

Tagged With 
This option only loads files which have had a tag applied. The default * value loads files with any tag. 
Tag names can be matched by adding the tag name (or names) in the text box to the right of the radio 
button. Matching is done via Regular Expressions, so multiple names can be matched if separated by a 
| symbol, and partial matching is also possible. A tutorial on Regular Expressions can be found here. 

Day Only 
This option only loads images where a 10x10 thumbnail image is not monochrome. It is useful for 
detecting animals which are only active during the day. Non-monochrome images are defined as those 
where at least one pixel has red, green and blue pixel values which differ by more than 4. Non-
monochrome images are recorded during daylight after camera triggering. This option slows loading 
considerably. 

Night Only 
This option only loads images where a 10x10 thumbnail image is monochrome. It is useful for 
detecting animals which are only active at night. Such images are produced at night when a change in 
the sensed infra-red radiation between two halves of the image triggers an infra-red flash. 
Monochrome images are defined as those where at no pixel has red, green and blue pixel values 
which differ by more than 4. This option slows loading considerably. 

Folder Paths 
Data sets may include hundreds of folders for different combinations of cameras, locations and 
epochs. This functionality allows filtering of folder names to only include folders containing specified 
text when the check box is ticked. Matching is done using Regular Expressions, so multiple match 
strings can be added if separated by a | symbol. 

Highlights 

 

Store in File Metadata 
The category, confidence value and corner co-ordinates of detections in the defined range can be 
stored in either in file name (if the File Name is selected) or in the Author metadata field (if Author is 
selected) if Store In File Metadata is checked. If File Name is selected, details of each detection is 
added as a comma-separated string between pairs of sequential underscore characters, giving file 
names of the form shown below: 
 
RCNX0118__117,1,0.968,0,0.116,0.141,0.735,__.JPG 
 
Processing is much faster when highlight information is stored in the file name. 
 
If the file name with detection metadata added exceeds 260 characters in length, detection metadata 
will be removed until the length is less than 260 characters. A warning will be logged if no metadata 
can be added to the name, but processing will not stop. Warnings can be viewed via the Errors top-
level menu item. 

https://regex101.com/
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Use Only Highest Confidence 
If Use Only Highest Confidence is checked, only the single detection with the highest confidence is 
stored. If it is not checked, multiple detections in the same image may be stored, sometime resulting 
in excessively long file names, is metadata is stored in the file name. Note that multiple animal 
detections will still be stored and be visible in Tag Occurrences if this option is checked. 

Show Existing Highlight Boxes from Metadata 
Checking this checkbox examines metadata for all loaded files to see if highlight data is stored and 
allows display of highlight detection boxes without reloading a JSON file. However, checking this 
option slows file loading considerably. 

Camera/Site and Epoch Folders 
Camera trap data from multiple cameras is usually stored as a folder tree where the camera name (or 
site name) is the folder name containing the images (parent) or the folder above this (grandparent). 
The folder defining the time period within which data below it collected is known as the epoch, and is 
the folder above the camera name or the folder one level above this depending on the setting of the 
Epoch Folder combo box. The value can also be set in the Pre/Post process Files screen. 

Open Folder/Re-open Folder 
To load files from a folder, the option File-> Open Folder… should be selected and the folder 
containing the files browsed for. The menu option File->Re-open Folder opens the last loaded folder 

again. If the data is on a removable USB drive, the top level folder (eg F: ) may contain an 

inaccessible System Volume Information folder. If this is present, data cannot be loaded using the 
drive letter as the opened folder. Data should be copied to a folder within the top folder of the drive in 
this case. 
 
If no folder has been previously selected, a browse screen is shown. After opening the folder, a screen 
similar to that shown below will appear if there is only one camera folder below the selected folder: 
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Options – Advanced 

 
Figure 18 Options - Advanced Tab 

Colours 
The colours used for highlight boxes and annotations in the time profile can be set from this area. 

Summary Date Grouping 
Tag Summaries can be presented over a time interval of a day, a week (with the week starting on the 
day as defined in the Summary Grouping box) or over all times. 

Show In Title bar 
These checkboxes control what information about the displayed file is shown in the title bar above the 
image on the main form. As file names may be very long if highlight data is stored in the file name, it 
may be useful to omit this if viewing only highlighted data. 

Example Images URL 
This specifies the URL to be opened when clicking on Example Images in the Presets screen. It should 
contain example images of all the expected animals. 

Only Show Detections with Used Categories 
If this option is checked, only detections from categories flagged with Use (in the General tab) will be 
stored. Otherwise, all detection are stored. Checking this option can speed processing where large 
numbers of tags are generated automatically. 
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Rebuild Tag Summary After Apply 
Checking this option rebuilds the tag summary after each tag is applied. This may take some time if a 
range of images have a tag applied to them via Batch Apply. In this case, this option should be 
unchecked and a tag summary generated after all images have been tagged. The Tag Summary and 
Occurrence appears as shown in Figure 86 on page 66. 

Show Tag Text on Count vs Time 
This option displays the text of tag beside the image highlighted in red if Show Tagged is selected in 
the screen shown in Figure 60. The display is as below: 

 

Only Set Tags from Presets 
If checked, tags can only be applied from the list shown in Presets. Tags cannot be entered or edited in 
the Tag box on the main screen. 

Store Animal Counts in Images 
If checked, the minimum and maximum number of animals appearing in a detection event is stored in 
the Tag Summary data. Checking this option slows processing. 

Add AutoTags to Existing Tags 
If checked, tags generated from Categories via the Name as Tag settings are added to any existing tags 
applied to tags already applied. This option is useful for comparing the performance of machine 
learning classifiers with manually applied tags. However, it slows processing. 

Add Mark String to Tags 
If checked, the mark string specified is prepended to any existing tags on load. This allows these tags 
to be excluded from the Clear operation executed from the Pre/Post Process screen. The action is 
implemented when data is reloaded after checking this option. Processing will be very slow as tags 
have to be retrieved from all files. The mark string should not be present in any tags. 

Store Detections 
If checked, detection details are stored in TagDB and are used for creating a Detections plot as 
described on page 72. Processing of JSON file is faster if this control is not checked. 

Auto-refresh Data Points 
If checked, all data points on the Count vs Time Plot are refreshed after applying a tag. The refresh 
process can be stopped by clicking Cancel. 

Max Gap (min) Creating New Detection Event 
This value specifies the time interval in minutes between successive images with the same tag above 
which a sequence is regarded as distinct from its predecessor. If the gap is greater than this value, the 
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sequence before and after the gap are regarded as different detection events. The default value is 10 
minutes. 

Max Gradient Interval 
The average gradient of the count vs time profile (in images per second) is shown to the right of the 
sequence when right clicking on point as shown below.  

          
Figure 19 Count vs Time Gradient with no animal present (left) and with animal present (right) 

Where a point is separated in time from its successor by more than the value specified, it does not 
contribute to the average value. Points contributing to the average value are shown in brown. A 
gradient value is not shown if there are no points contributing to it. 
 
The gradient value is useful in determining whether the camera is being triggered by a moving animal 
or by moving vegetation. Gradient values are generally higher if an animal is causing the camera 
triggering.  

Gradient Points 
The value set in this box sets the maximum number of points over which the average gradient is 
calculated. Points may not be used if the time interval exceeds the threshold set in Max Gradient 
Interval. 

Map Category Codes 
This functionality is only required is using an Australian species refinement classifier with EcoAssist 
5.2. The Browse button should be used to select the file C:\Program 
Files\EcoAssist_files\models\cls\Goanna\class_list.yaml. It should be unchecked in other cases. 

Truncate Camera Name to Length 
The camera name will be truncated to the specified number of characters if the length is less than the 
specified value. 

Truncate Epoch to Length 
Epoch will be truncated to the specified number of characters if the length is less than the specified 
value. 

Copy Loaded 
This option allows loaded files to be copied to a destination folder. Folders below the destination 
folder contain data from folders below the loaded folder. This option allows saving of a copy the data 
after applying any of the filters specified in Options. 
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Pre/Post Processing 
The File->Pre/Post Processing screen as shown below is used to perform a number of pre- and post-
processing functions: 

 
Figure 20 Pre/Post Processing screen 

Clear Detections 
Any highlight data stored in the file name or the Windows Authors field of file metadata is cleared via 
this button.  

Clear Tags 
Tag data stored in the Windows Tag metadata field is removed via this button. If Only Unmarked is 
checked, only tags which to not contain the mark string defined in Options are removed. Processing is 
much slower if this option is checked 

Check for Corrupt Files 
Corrupt JPEG files may appear in the loaded data and cause the program to crash or behave 
unpredictably. Clicking the Check button with Delete checked will remove these files and reload the 
data. The Pause checkbox allows processing to pause if a corrupt file is found. Processing may take 
some time for large file collections. A list of corrupt files is created in the loaded folder with name 
CorruptFiles.txt. 

Camera 
The Info button in the Camera box shows the epoch over which images were recoded, the camera 
name and manufacturer, the number of files in the camera folder, the Modified dates of the first and 
last files in the camera folder, and the duration of the time interval between recording of the first and 
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last images as shown below. Data must be loaded in Path or Folder->Modified Date order (as selected 
in the Options screen. 

 
Figure 21 Camera Data Information 

CameraName is the name of either the grandparent or parent folder of the file containing the images. 
The Epoch of images in the Camera folder is the folder either 1 or 2 levels above the Camera folder as 
selected by the Epoch Levels Above combo box. If the duration of a particular folder is much greater 
than others, or is negative, this may be due to the presence of some images with inconsistent dates. 
These can be removed via the Edit By Time button. 

Folder Tree 
This button creates a file showing the folder structure beneath a selected folder and whether that 
folder contains any JPEG files. The file is displayed by Notepad on completion. This display is useful for 
ensuring that the folder structure is amenable to automated analysis with CamTrap Pro 

Re-order 
This option is used to reorganise data grouped by epoch and camera to be grouped be grouped by 
camera only. Folders with the camera name (optionally truncated) will be created in a folder named 
Shortcuts which is created in a selected folder. Within each camera folder, shortcuts to the camera 
folder for each epoch will be created as shown below. 

 
Figure 22 Shortcut folders created to display data organised by Epoch 

Shortcuts to folders are processed in alphabetic order, so the Epoch names should be changed to be in 
the desired order in order to create profiles such as the one shown below. Where numbers are 
included in the Epoch name, shortcut names should be padded with leading zeros. Epoch rather than 
camera changes are shown on the plot as shown below: 
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Figure 23 Count vs Time profile from shortcut folder 

Note that if shortcuts are created on an external drive mapped to a drive letter, the shortcuts will only 
work if the drive has the same mapped letter. If it has changed, the message “No image files below 
selected folder” will appear. The drive letter used is shown in the name of a file created in the 
Shortcuts folder. 

Check Seq 
This option is used to detect when the image sequence number embedded in the file name increases 
by more than one in sequential files, indicating that a file is not present. The distribution of time 
intervals (in seconds) between successive images is also shown. The filesystems used on the SD cards 
containing the camera images do not usually record times to an accuracy of less than 1 second. A text 
file listing is created in the loaded folder with the name MissingFilesAndIntervalDistrib.txt and this file 
is shown in Notepad on completion. 

Remove Detections with Confidence Below 
When processing large data sets from multiple cameras, there may sometimes be large numbers of 
low-confidence detections in the Tag database. If this is the case, the display of all detections may be 
very slow. It can be sped up by removing the low-confidence detections from storage. Once this has 
been done the lower limit of the detection range will be the maximum of the value set and the value 
specified in the text box (default 0.1). 

Edit By Time 
Pre-processing may be necessary to obtain correct recorded dates. If no date/time is set on the 
camera, the first image date/time recorded will be the default date/time (often the date of camera 
manufacture) or the date/time of the last use of the camera. The time interval between images will be 
correct. In order to correct this, the date/time of the first image can be set in Options and the 
Modified date of subsequent images set to this date/time plus the date/time difference between this 
image and the first image. If the first few image use the default date/time and later ones use the 
correct date time, these default date/time images should be removed to ensure that the count vs time 
profile is comparable with cameras with the correct date setting. This operation can be performed via 
the Edit By Time button. This allows deletion of images within a selected time range via the count vs 
time profile for the loaded files as shown below: 
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Figure 24 Edit by Time screen 

If Delete is clicked after dragging a box around points to be deleted, images corresponding to points 
within the box will be deleted after confirmation. Images corresponding to points can be viewed by 
right-clicking on the point. 

Resample 

 
Figure 25 Resample Options 

This option allows resampling and adjusting of the loaded images to pixel dimensions either 1x, 2x or 
4x smaller, depending on the Factor setting. The contrast and brightness attributes of images can be 
adjusted via the Contrast and Brightness values, which must be between 0.5 and 2.0. Increasing the 
values above their default values of 1.0 increases the attribute, and reducing it to less than 1.0 reduces 
it. 
 
If a string is provided in the ‘Copy rather than resampled files with’ text box, files containing the string 
in their path are copied rather than resampled and their attributes are unchanged. This allows 
selective resampling. If Full Path Below Folder is unchecked, the subfolder identifies the camera folder 
and is either the name of the parent folder, or the name of the grandparent folder followed by the 
parent folder name of the current image file. If the checkbox is checked, the entire path of the folder 
(without the source drive letter) containing the file is appended to the selected drive or folder and is 
the destination folder for processed files. Any existing folders or files in the destination folder are 
deleted. 
 
Files containing a specified string in their path can be excluded from resampling and are copied to the 
destination folder unchanged. 
 
Resampling speeds up certain CamTrap Pro operations, such a slideshow display and detecting 
changes between images and increases the speed of machine learning processing by applications such 



 

 31 Aleka Consulting 
  www.alekaconsulting.com.au 

as EcoAssist. Resampled files have only the EXIF fields Date Taken, Date/Time Original and Date/Time 
Digitized copied from the loaded files. Adjusting contrast or brightness may improve the performance 
of machine learning algorithms in detecting animals. 

Rename Folders Below 
This option is used to change the name of folders below a selected folder to include the name of their 
parent folder in their name. The folders which have their name changed are one level up from the 
bottom of the folder tree. The folder tree should have all image files at the same level. An example of 
the changed name structure is shown below: 

 
 

 
Figure 26 Folder Tree before (Top) and after (Bottom) renaming 

 
It is used when there are multiple cameras per site which need to be distinguished if existing camera 
names (for example, Left, Right and Centre) are repeated at different sites.  

Rename File to Sequential Numbers 
This option is used to change the file name to the position of the file in the loaded sequence. It is used 
if file names do not contain sequential numbering. 
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Project Details 
 The name of the project and the site over which cameras are deployed can be specified via the File-
>Project Details option, which shows the screen below: 
 

 
Figure 27 Project Details screen 

Project Name is the name of project (eg Deer Control) and Site Name is the name of the group of 
cameras whose data is being processed. All parameter are optional, but Map functionality will not be 
available unless a camera location file is specified. The camera location file is a tab-separated text file 
with three columns of data per line. The first column should contain the camera name (eg A_M01). 
The second and third columns should contain the latitude and longitude of the camera in decimal 
degrees. 

Consolidate TagDBs 
This option is described in Consolidating Summaries in the Analysis section. 

Processing Data from Multiple Cameras 
Data from multiple cameras can be processed in one pass by CamTrap Pro by selecting the folder 
above the individual camera or site names. File Order in Folders should be set to Modified Date for 
Folder->Modified Dare, and the Modified Date of images should be set to the time at which the image 
was recorded. Incorrect Modified Date values may be due to processing after image capture altering 
the image Modified Dates, or camera internal clocks not being correctly set. If Modified dates are not 
reset, the Count-Time profiles will not appear as shown in the examples, but may have a stepped 
appearance over a short space of time. If the aim of processing is only to detect the appearance of 
particular animals, Modified Dates do not have to be reset, but time durations in the summary report 
will be incorrect. 
 
If multiple folders are present below the selected folder, the screen below appears: 

 
Figure 28 Multiple camera data folder screen 

Selecting No treats files as though they were in a single folder, and count vs time profiles are stacked if 
folder order is Folder->Modified or summed as a single profile if order is Modified. Selecting Yes allows 
selection of camera data sets as shown below as multiple folders and displays count vs time profiles 
starting from the origin. 
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Figure 29 Multiple camera selection screen. 

The bracketed number after the camera name is the number of files in the folder. This is only shown if 
the sorted order of loaded files is Folder->Modified. The name of the TagDB database created in the 
selected folder includes the data site\epoch, and the first n characters of the selected camera folder 
names, as specified in the No. of chars to use in TagDB name combo box. If more than one camera is 
selected, camera names are separated by commas. The option to change the camera name folder 
between Parent and Grandparent is shown. If OK is selected, data from the each of the selected 
camera data folders will be loaded into CamTrap Pro ordered by Modified Date within each camera 
name folder, where camera name folders are sorted alphabetically.  
 
Selecting Analysis->Count vs Time, shows profiles for each camera separately as a stack as shown 
below: 

 
Figure 30 Count vs Time Profile of Data from Multiple Cameras 

The name of the camera for each profile can be shown by moving the cursor over a non-horizontal 
part of the line profile. 
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After loading JSON data, each animal detection within the default detection range (currently 0.4 to 
1.0) is marked as a blue highlight dot: 

 
Figure 31 Multiple camera count vs time with animal detections highlighted 

Selecting Highlight->Megadetector->Copy copies all highlighted images to sub-folders of the 
Highlighted folder, where the sub-folder names are the names of the multiple cameras. This data can 
then be loaded into CamTrap Pro for tagging and summary generation. Highlighted images can either 
be ordered within the camera folders they came from or collectively. 

Tagging by Visual Inspection 
Once the files are loaded, tags may be applied by visual inspection of each image using the Slideshow-
>Play option, which shows all the loaded images in the order selected in the Options screen. (For the 
Camera Trap options, this is Date Taken.) Ctrl-P toggles the slideshow between playing and pausing. 
The time between image displays can be selected in the Options screen or via Slideshow->Interval and 
should generally be 250 msec. If an image takes more than 250 msec to load, as can happen for large 
images, the time interval will be increased to the first multiple of 250 msec greater than the load time. 
If an animal appears in an image, the slideshow should be paused and moved backwards if required 
using the left arrow key. Tags selected from the Presets menu (shown by clicking the Presets button as 
shown below) can then be added to the image, or entered directly if allowed. 
 

 
 
If the same tag is to be applied to multiple files (as will often be the case), this can done via the Time 
Analysis screen as described in Processing Multiple Images. 
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Viewing Data 
 
The Start screen for CamTrap Pro is shown below: 

 
Figure 32 Main Screen after starting CamTrap Pro 

Input data is loaded via the File->Folder option. For single-camera data, the selected folder should be 
the parent or grandparent folder of the image files. For multiple camera data, the selected folder 
should be above the folder containing all the individual camera data sets. The images must be 1 or 2 
levels below the folder identifying the camera as shown in Figure 6. 

 
Figure 33 Folder Browse screen showing sort order 

The sort order can be changed via the Options screen. Modified or Folder->Modified order gives faster 
operation than Date Taken. If Modified Date is not the same as Date Taken it can be updated from 
Date Taken in the Options screen. After loading the data, the Move and Find buttons are enabled: 
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Figure 34 Main screen after loading data 

Zooming 
Preset zoom factors of 100%, 150% and 200% can be applied via the Zoom menu items. Holding the 
Shift key and pressing the Up key zooms the image by a small amount, and Shift-Down un-zooms it. 
Any tags which have been applied to the loaded data are shown in the box to the right of the Tags 
label. The Move button displays the image with sequence number shown in the box to the right of it.  

Find 
The Find button ( ) shows the screen below: 

 
Figure 35 Find Image Screen 

Entering a string in the Search String box shows the first loaded file whose path contains the string 
(often the numeric part of the file name). Other matches are shown in the results combo box. These 
can be shown by selecting them. 

Slideshow 
SlideShow->Info displays this section of the help file. 
 
Slideshow->Play displays all images starting from the first one at a time interval selected from the 
Slideshow->Interval menu item. The keyboard shortcut for this menu item is Ctrl-P. Other slideshow 
options are as shown below: 
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Clicking the Play menu item or Ctrl-P on the keyboard displays each item sequentially from the 
sequence number defined by Move Play Start To for a period defined by the Interval menu option, and 
the menu item name changes to Pause. The Stop menu item (with keyboard shortcut esc) is now 
enabled, and clicking it returns to caption entry mode. After clicking Stop, clicking Play resumes 
playback from the stopped sequence number. Clicking the menu item now named Pause (or clicking 
Ctrl-P again) stops slideshow playback. Clicking this (or Ctrl-P) resumes playback. The position at which 
playback is resumed is controlled by the Move Play Start To menu option, which is shown in the screen 
below: 

 
Figure 36 Move To screen 

The Step Forward and Step Back controls move to the next or previous item in the slideshow. The left 
and right arrow controls provide the same functionality is no caption or sub-caption text is present. 
The sequence number of an item is shown at the top left of the screen as shown below with sequence 
number 18: 

 
 
The Pause On Change option n sets parameters to allow the slideshow to automatically pause if there 
is a change between the currently displayed image and its predecessor. It is only used if showing 
camera trap data as a slideshow. More details in the help document Processing Camera Trap data 
 
Copy To Folder (or Ctrl-K) allows copying of the current image (and optionally images ahead or behind 
the current image via the Images Ahead and Images Behind combo boxes) to a folder, the default 
value of which is My Pictures/Camera Trap Images via the screen below: 
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Figure 37 Copy to Folder screen 

A different folder can be selected via the Browse button. If an image file with the name shown above 
already exists in the folder, the saved file name has an integer appended to the file name before the 
file extension (eg IMG_0048(1).jpg).  

 
Start and End change the current item to the first or last loaded item. 
 
Interval sets the time period of the timer displaying image files via the screen below: 
 

 
Figure 38 Setting slideshow interval 

 
If the time period is shorter than the time taken to load the image (as may happen for large images, a 
short period, or a slow computer), the image is displayed on the next tick of the timer, so the actual 
period between displays will whichever integer multiple of selected period is greater than the time 
taken to load the image. The actual speed of the slideshow depends on the size of the images, the 
storage access speed and the speed of the computer being used. Using a 3.5 Ghz, 6-core computer 
with 2688x 1504 pixel images processing images on an external USB drive, a speed of 4 images/sec 
was obtained. 
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Metadata 
Metadata for the currently viewed file can be shown by clicking the Metadata top-level menu item. 
Metadata from the Windows filesystem is shown first, then image-specific metadata. There may be 
hundreds of fields present. ICC Profile entries for red, green and blue are not shown as they are very 
long. An example of camera trap image metadata is shown below 

 
Figure 39 Metadata (part) of camera trap image 

Errors 
Errors generated in the course of CamTrap Pro operation can be viewed by clicking the top-level Errors 
menu item as shown below: 

 
Figure 40 Errors from Current Instance 

The default option is to show only errors which have occurred during the current run, (Current 
Instance in the combo box to the right of the error display) but errors from all runs can also be 
displayed: 

 
Figure 41 Display of All Errors 
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Adding Tags Manually 
If single camera trap images are to be tagged, text may be typed in directly to the Tags Box and 
applied either by tapping the Enter key or by clicking the Apply button. 
 
Semicolons should not be used in tag names. Tag Information can be displayed in Windows Explorer 
using Details view: 

 
Figure 42 Windows Explorer details view showing tags 

Using Pre-set Values for Tags 
If users wish to select tag values from a list rather than typing them in, this can be achieved via the Tag 
button on the main screen which shows the screen below. If Presets Only on the Advanced tab of the 
Options screen is checked, tags can only be added via this screen. 

 
Figure 43 Preset Tag Screen When no Files Loaded 

As there are no pre-defined pre-set text options, only the Add and Close buttons are enabled, Clicking 
Add shows the screen below, which allows definition of one or more pre-set texts. 

 
Figure 44 Screen for Adding Preset Texts 
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Multiple strings (the names of animal expected to appear) can be loaded from a text file in which each 
string is on a new line using the Read From File button or they can be pasted using one line per name. 
After clicking Add and then Cancel, the texts added appear in the main Tag screen as shown below: 

 
Figure 45 After Adding Pre-set Texts with one Item Selected 

If example images for the expected animals are available, these can be placed in a URL and specified in 
the Advanced tab of the Options screen and viewed via the Example Images button. 
 
Clicking Apply adds the tag to the image.  

 
Figure 46 After applying tag 

Tags can be removed by clicking Clear and then Apply. If multiple tags are checked, they are separated 
by semicolons in the Tags box. 
 
One or more checked texts can be deleted via the Delete button (after confirmation) and if a single 
text is checked, its value can be edited via the Edit button. 

Processing Multiple Images 
Adding tags to a sequential group of images is performed via Tag Multiple button the Analysis-> Count 
vs Time screen which shows the Show Tags or Highlights screen. The Show Highlighted, Show Tagged 
by CamTrap Pro and Show Tag on Count vs Time options should be checked as shown below. 
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Figure 47 Show Tags or Highlights 

With the options shown above, Count vs Time points will appear as shown below if no highlights have 
been generated via loading of the JSON file from machine learning analysis. 
 

 
Figure 48 Count vs Time screen with no highlights or tags created 

If highlights have been created for images, these are shown as below: 

 
Figure 49 Count vs Time showing Highlights on almost all files 

The sequence numbers of the first and last images displayed and the number of images with 
detections above and below the threshold value are shown below the chart.  
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Tag Multiple 
Clicking the Tag Multiple button shows the screen below, which extends the functionality of the 
screen shown in Figure 43. 
 

 
Figure 50 Tag Multiple screen 

Once the image has been inspected and the species present identified, one or more tags can be 
selected from this screen. Example images for different species expected to be present can be viewed 
via the Example Images button. 
  
If Build Tag Summary after Application is checked, the Tag Summary is refreshed after tags have been 
applied. If Add to Existing Image Tags is checked, tags selected are added to those already existing. 
The Tag combo box All options applies tags to all files visible on the Count vs Time screen. Tag 
application may be slow if the same animal appears in a large number of images. The 1st in Det Event 
option only applies selected tags to the first image in a detection event, the duration of which is 
specified in Options. This option is useful if there are a large number of images of the same animal, for 
example, a carrion-eater attempting to eat a bait. If this option is used, the number of images in the 
tag summary will always be 1 for each detection event, and the duration will be zero 

View Image 
If a filter has been applied when loading files (for example to show only highlighted files), species 
recognition may be improved by viewing zoomed images, images rejected by the filter or images 
existing at a higher resolution in another folder using Windows Photo Viewer. This facility is accessed 
via the View Images button on the Time Analysis screen. Clicking it shows the screen below: 

 
Figure 51 View Image in Folder Screen 

The default is to search for the file in the loaded folder. If a copy of the loaded folder (perhaps 
containing images at higher resolution) is available, this can be selected via the Browse buttonThe 
default folder to search in can be restored via the Reset button. If the file exists in the selected folder, 
clicking OK shows it in Windows Photo Viewer as below: 
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Figure 52 Selected Image Viewed in Windows Photo Viewer 

The image displayed can be zoomed, or the displayed file can be moved backwards or forwards in the 

selected folder via the  or  button. Viewing other images than those highlighted may assist with 

species identification, as may using the zoom button  to show a zoom slider: 

 
Figure 53 Windows Photo Viewer Zoom Slider 

If an image is viewed in Windows Photo Viewer, closing it will also close the View Image in Folder 
screen shown in Figure 51. While the image is shown, the View Image in Folder screen is disabled and 
cannot be closed. 

Adding Tags 
Selecting a tag copies it to the Tag text box. If more than one tag is selected, all selected tags are 
copied separated by a semicolon. The Clear button clears the tag box and unselects all preset values. 
Applying an empty string removes any existing tags if Add to Existing is not checked. If Add to Existing 
is checked, any existing tags will have the selected tag (or tags) appended to the tag string with each 
tag separated by a semicolon. If Build Tag Summary on Completion is checked, a Tag Summary will be 
generated which can be viewed via the Analysis->Summarise Tags menu item and clicking No at the 
prompt below: 

 
Figure 54 Screen to optionally rebuild tag occurrence and summary data 

The start and end values are the sequence numbers of the first and last images displayed in the Count 
vs Time screen, which can be changed by zooming the display. By selecting a region of the Count vs 
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Time display showing a sequence of images captured over a short time (as below), multiple images of 
the same animal can be tagged.  
 
If Build Tag Summary on Completion is checked, a tag summary is generated automatically on 
completion, and added tags can be displayed on the count vs time profile as below: 
 

 
Figure 55 After applying a tag to multiple images 

Tag text is added where the is a space of more than 5 pixels between tagged points. 
 
Clicking Analysis-> Summarise Tags prompts the use to choose between rebuilding the summary or 
displaying one already created. If the option to Rebuild Tag Summary on Completion has been 
selected on the Tag Multiple screen (shown in Figure 50), No should be selected. 
 

 
Figure 56 Tag Summary Screen 

The Tag Summary screen is discussed in more detail on page 64 
 

Editing Tags 
Existing tags are shown below the image on the main screen when the image is loaded. These can be 
edited and reapplied via the Apply button. If identification of individual animals is required tags can be 
changed to include a unique identifier. 
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Deleting Tags 
Tags on individual images can be deleted using the Clear button at the lower right of the main 
CamTrap Pro screen. To remove tags from multiple images, any text should be deleted from the Tag 
box and the batch operation should be run using the batch button. To remove tags from all images, 
click the Tags button in the Clear box in the Pre/Post Processing screen.  
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Adding Tags Automatically 
Tags can be generated automatically by loading a JSON file produced by the Megadetector classifier, 
optionally refined. Detections of categories without the Use column checked in the Machine Learning 
Categories grid will be ignored. The default settings show Megadetector categories and only use 
Animal detections. If the Show All is selected, all detections within the specified range in a single 
image will be highlighted. Tags can be generated as well as highlights by checking the Name as Tag 
option for the category. Whenever detection confidence falls within the defined limits, a tag 
corresponding to the category name will be applied, and a red square will be shown on the count vs 
time profile if Show Tag on Count vs Time is checked when Count vs Time is loaded as shown in Figure 
60. 

Refining Megadetector Results 
 Auxiliary programs such as EcoAssist allow Megadetector results to be refined to identify particular 
species as shown below: 

 
Figure 57 Automatically generated tags using refined Megadetector results 

When a refining classifier is used with EcoAssist, two JSON files are produced. The file 
‘image_recognition_file.json’ should be selected. The red squares indicate where the refined 
classification confidence exceeds the classification limit, dark blue triangles where an animal has been 
detected, but the refined classification does not exceed the classification limit, and light blue dots 
where no animal was detected with a confidence greater than the detection limit. Limits are defined in 
the Advanced screen of EcoAssist as described on page 80. 
 
If individual images are shown by right-clicking on a red square or dark blue triangle, the bounding box 
of the detection will be shown, but the category name will only be shown if the classification limit has 
been exceeded. 
 
The Highlight->Copy to Folder option will copy highlighted files and tagged files to the selected 
destination.  
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Previously Tagged Data 
Images with tags previously created by other means can be loaded and viewed in the same way as 
untagged data, and analysed in the same way as if the images have been tagged within CamTrap Pro 
However, no data on the minimum and maximum number of animals appearing in a tag occurrence 
will be available. 
 
Checking Name as Tag will apply tags corresponding to category names as well as creating highlights 
giving results as shown below for a dataset collected from a road with significant vehicle traffic. 

 
Figure 58 Results of setting Name As Tag for 3 different categories of automatic classification 

Points shown in red are detections with the displayed category. From this data it can be seen that the 
increase in detections after 1/11/2011 is largely due to vehicles. 
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Analysis 

 
Figure 59 Analysis Options 

These options analyse the camera trap image collections. 

Count vs Time 
This option shows a cumulative count vs time profile of the images similar to those shown on pages 
14-15. An option to show generated highlights, tags created by the current instance of CamTrap Pro, 
tags retrieved from file metadata, or below-threshold detections is shown as below. Checking Show 
Tags from File Metadata option will be slow display of the count vs time profile. 

 
Figure 60 Show Tags or Highlights Options 

Files with highlights created by machine learning are shown in blue (by default) and tagged files in red 
(by default) if the corresponding boxes are checked. Tag names are added if Show Tag on Count vs 
Time is checked. Files with detections with confidence below the lower threshold are shown in orange 
(by default). Default colours can be changed in the Options Advanced tab. The current file shown on 
the main screen is shown as a green circle. 
 
For a multi-camera data set using Folder>Modified ordering, individual camera profiles are stacked 
and labelled as shown below. Note that the input data must be reloaded to manifest changes in 
ordering. 
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Figure 61 Count vs Time profile using Folder->Modified ordering 

Show Start shows the first file loaded. Time Grid Interval allows selection of the time interval between 
vertical lines on the profile. The function of the View Image button is described on page 43, and that 
of Tag Multiple on page 32. 

 
If Modified ordering is used, the individual camera profiles are summed as shown below: 

 
Labelling of data from individual cameras is not shown in this case. 
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If Show Tagged is checked, applied tags are shown as below in a colour specified in Options: 

 
Figure 62 Count vs Time with Tags Images shown 

If Show Highlighted is checked, highlighted images are shown as dots in a colour specified in Options: 

 
Figure 63 Count vs Time with Highlighted Images Shown 

Profiles can be displayed as either lines or points (coloured light blue) as specified with radio buttons 
at the bottom right. The arrow buttons to the right of the radio buttons move the selected point left 
or right along the sequence. 
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Figure 64 Count vs Time in Point mode 

If the profile contains a number of large sharp steps as shown in Figure 48, this indicates that animals 
are moving in the viewed scene for some time and that tags need to be applied in bulk. This can be 
done manually in CamTrap Pro, or using the Exif Pro application, which allows application and removal 
of tags to a subset of loaded images. Megadetector uses machine learning to automatically detect 
animals in images and can be accessed from CamTrap Pro and applications such as EcoAssist. Output 
from this process can be loaded into CamTrap Pro. 
 
The appearance of large step in the Count vs Time profile (as shown in Figure 48) indicates that an 
animal moving in front of the camera is triggering it more often than the more random false 
triggerings from moving shadows or vegetation. The profile can be zoomed by clicking and dragging to 
create a box around the area of interest (near the origin) as shown below left. The zoomed display is 
shown below right. 

  
Figure 65 Zoom box defined on Count vs Time profile (left) and zoomed display (right) 

The sequence number of the image corresponding the cursor x location is shown in the lower left-
hand corner when the cursor is within the profile area. 
 
The Show Start button shows the first image after the start of the displayed region, and right-clicking 
on the display near a time-count point shows the image. If only a single time/count point is within 5 
pixels of the cursor, the cursor changes to a + and right-clicking shows the image. If more than one 

https://download.cnet.com/ExifPro/3000-12511_4-10436338.html
https://github.com/microsoft/CameraTraps/blob/main/megadetector.md
https://github.com/PetervanLunteren/EcoAssist
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point is close to the cursor, the cursor changes to a hand, and right-clicking shows the image with the 
lowest sequence number. The selected image point is shown in green, together with the sequence 
number as shown below. The average gradient at this point of the profile is shown to the right of the 
sequence number 

 
Figure 66 Display after right-clicking near graph point 

The image sequence number (510) is shown in both the Count vs Time Profile and in the title area of 
the main CamTrap Pro window. Changing the displayed image with in the main CamTrap Pro window 

(via the  and controls at lower left or the left (or down) or right (or up) arrow keys on the 

keypad), changes the point shown in the Count vs Time profile, allowing graphical viewing of the time 
interval between images. The displayed image can also be changed by arrow buttons to the right of 
the line/point selection buttons. Clicking View Image displays the selected image in Windows Photo 
Viewer, which permits display of neighbouring images which are not necessarily loaded, or higher 
resolution images which have not been loaded at all. 

Highlight 
An image highlight indicates that an image may contain an entity of interest. Highlighting options are 
accessed via the Time Analysis Menu as shown below: 

 
Figure 67 Highlight Options 

Sequences.. highlights groups of images appearing in a rapid sequence. Cameras are frequently 
configured to record 3 images spaced by 1 second after triggering, so Sequence count should be 
greater than this in this case. Changes ... highlights images which differ from their predecessor or an 
average of their predecessors in hue or luminance. Images are resampled to a much smaller size 
before comparison. Both may detect the presence of animals in images but both suffer from false 
positive and negative detections. The Megadetector->Load Output options allows loading of the JSON 
file produced by Megadetector and detections with a confidence within the confidence range are 
highlighted. Megadetector->Confidence Range sets the confidence range for highlighting. Images 
where there is at least one detection below the lower confidence limit and no detections over the 
limit are highlighted in orange (by default). The colour of highlights and below-threshold detections 
can be changed in the Advanced tab of the Options screen. 
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The options are discussed in more detail below. Highlight and below-threshold results can be quickly 
inspected by right-clicking on the blue triangles or orange squares created by the process to show the 
image at the highlighted time. When a highlighted image is shown on the main screen the form (and 
taskbar) icon changes to a red background as shown below: 

 

 

 
 
 
Figure 68 Highlighted image (top), Image with below-lower-threshold confidence(middle) and non-highlighted image 
(bottom) 

If highlight metadata is stored in the file name, images with highlights contain a string defining the 
detection confidence and the positions of the corners of the bounding box between the strings __0, 
and ,__ before the file extension. Images with at least one detection below the lower limit of the 
confidence range have the string !! added in the file name before the file extension. 
 
Inspecting the results of applying the filter defined in Options to show only below-threshold 
detections allows the effectiveness of the confidence range defined to be tested. If animals of interest 
are found in the displayed images after filtering (which can be quickly examined via a slideshow), the 
lower limit of the confidence range should be decreased. However, this will result in an increased 
number of false detections. 

Sequences 
As an animal may only appear for in a few images out of several thousand, the step in the Count vs 
Time profile caused by its appearance may not be perceptible. The Highlight->Sequnces option allows 
highlighting of points on profiles where the time interval is less than or equal to a number of seconds, 
over a number of contiguous images as shown below: 

 
Clicking highlight shows blue points at images where this condition is satisfied: 

 
Figure 69 Highlighted points on Count vs Time profile 

Clicking on highlighted points shows the image in order to see if the sequence is caused by the 
presence of an animal. 
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Changes 
The Changes option places a highlight of selected colour on a time profile if a number of pixels in an 
image which differ in Hue, Luminance (or a combination of them) from their predecessors or an 
average of them. It can be used to detect the presence or movement of an animal in an image, or if 
the shadow pattern in an image changes. If the animal hue and luminance are similar to that of the 
background, no detection will occur will occur. Change detection is most useful where there are a 
large number of false triggerings from vegetation or shadow movement. 
 
The screen which appears when selecting this menu item from a Time Analysis profile is shown below: 

 
Figure 70 Change detection screen 

A time profile point is highlighted when an image differs from its predecessor or an average of its 
predecessors. Images are first resampled down to dimensions selected from the Resample Image Size 
options, which are between 15 and 960 pixels with a 5:3 aspect ratio. Each pixel is then compared to 
the corresponding pixel of its predecessor or an average of a number of predecessors (as defined by 
the Average Over using the criteria shown below: 
 

Comparison Mode Highlighted When 

Luminance Only Luminance change exceeds threshold and number of pixels changed 
between Min and Max 

Hue Only Hue change exceeds threshold and number of pixels changed between Min 
and Max 

Hue and Luminance Hue Change and Luminance change exceed thresholds and number of pixels 
changed between Min and Max 

Hue or Luminance Hue Change or Luminance change exceed thresholds and number of pixels 
changed between Min and Max 
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The currently selected image can be compared with its predecessor (or an average of its predecessors) 
via the Compare button, which shows a screen as below: 

 
Figure 71 Comparison of Selected with Preceding Image 

The resampled image is shown, with any pixel meeting the threshold criteria framed in red shown at 
the top. The line of pixels at the top and left-hand side are not correct. Hue and Luminance changes 
for each pixel are shown below, with change values greater than 9 replaced by a + in order to maintain 
a compact grid structure. Over threshold pixels are marked with x rather than 0. The original pixels 
within the image are also enclosed a red box as shown below: 

 
Figure 72 Pixels within original image showing above-threshold change. 

Change detection does not match human or machine learning performance in animal detection in an 
image. Its advantages over computer vision facilities such as Megadetector are that it is fast, and does 
not require access to training data or powerful computing resources. However, its performance is 
highly dependent on the correct choice of parameters, and the optimum parameters for any data set 
will depend on the nature of the scenes shown in the images, and the expected size and colour 
contrast of the animal to be detected. The ideal method of setting parameters is to find an image 
containing an animal preceding one or more images which do not contain the animal. The pixel size 
should then be adjusted so that the animal is contained in the majority of a single resampled pixel. 
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Change threshold values should then adjusted so that the pixel containing the animal is the only one 
meeting threshold criteria. The Minimum number of pixels changed should be set to 1 in this case, and 
the maximum to the largest number of resampled pixels containing the animal. Detection should then 
be tested over a number of images, including one containing the animal. Setting the Average Over 
value to a value >1 may improve precision and recall of detection. 
 
Parameter values used will depend strongly on the number of pixels changed by the presence of an 
animal and the degree of contrast between the animal and the background. Some experimentation 
will always be required. 
 
The Highlight button applies the change algorithm to all loaded images and highlights those which 
meet the criteria. These images can be copied to a separate folder for tagging. 
 
Remove Highlights removes all highlight data from loaded images. 

Machine Learning 
The Machine Learning options allow reading of JSON files created by auxiliary applications such as 
EcoAssist. Internal application of Megadetector is not currently implemented. A histogram of the 
maximum confidence value for any detected entity for all loaded images can be generated, or images 
with values within a defined range can be highlighted in the time profile. The Megadetector options 
are shown below: 

  
Figure 73 Machine Learning options 

After processing, images with any animal detection with confidence between the upper and lower 
bounds will be highlighted as shown below: 

 
Figure 74 Megadetector detections highlighted 

Selecting the Copy option after highlights have been shown allows each detection to be analysed 
visually and appropriately tagged. 
 
Machine learning processing uses a neural network to classify images on the basis of training sets, 
which need to be quite large to obtain reliable results. The Megadetector model has been trained on a 
large number of images and is very accurate for large mammals, but works less well for reptiles. 
However, the detection of similarity may rely on completely different features from those perceived 
by humans, giving rise to false negative and positive detections, especially when large numbers of 
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training images are not available or where there is little contrast between the animal and the 
background. Some examples of false positive and negative detections of a lizard are shown below: 

  
 

 
 
Figure 75 False positive and negative detections using Megadetector 

The top image shows two false positive detections (albeit with low confidence) and one correct 
detection of a lizard. The bottom image shows a false positive and a false negative detection – the 
lizard is present at the bottom right of the image but has not been detected. 
 
  

Load JSON File 
The Load JSON File option allows output from classifiers such as EcoAssist to be used to highlight 
images. This output is in the form of a JSON format file created in the selected folder of the classifier.  
If EcoAssist is run on a different machine from CamTrap Pro, the option Use Absolute Paths in the 
Advanced view of EcoAssist should be unchecked. The folder selected in CamTrap Pro should be the 
same as that selected in EcoAssist. 
 
Selecting a file on the Count vs Time profile highlights images on the time profile where the maximum 
detection confidence of an animal is within a range defined by the Confidence Range menu item and 
the file path in the JSON file matches the path of the loaded file, or the file name matches that of the 
loaded file depending on the Options setting. The default confidence range is 0.5-1.0. The progress bar 
for loading JSON data moves at a highly variable speed depending on the confidence range selected, 
so estimated completion times will generally not be accurate.  
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If metadata is added to the file name (via the Store in File Metadata option in the Highlights box), the 
path length may exceed the Windows limit of 260 characters, especially if multiple animals are 
detected in the same image and detection data is stored in the file name. In this case and option to 
remove detections until the path length is less than the Windows limit, or to Use Only Highest 
Confidence detection in each image. Note that multiple animals will still appear in Tag Occurrences 
even if this option is checked. 
 
Progress in loading the file is shown in the screen below: 

 
The Estimated Duration will generally change during loading, being more reliable as a greater 
proportion of the file is processed. Loading is faster is Store Detections is unchecked in the Options 
Advanced screen, but the loading process still takes many hours if hundreds of thousands of files have 
been loaded. 
 
If the paths created from the JSON data do not match the loaded paths, the following screens are 
shown. The “No Highlights Shown” screen is also shown in the circumstances shown on the screen. 

 
If Yes is selected, the paths extracted from the JSON file can be compared with those stored by 
CamTrap Pro. If any highlights are created and the option to store highlight metadata in the file name 
is selected the file name will be changed to include the detection confidence and bounding box co-
ordinates where detection confidence exceeds the threshold value. The option to reload data with 
changed metadata, optionally showing only highlights as below is then presented. 

 
Figure 76 Reload option after loading JSON file. 

If Reload Highlights Only is checked, the default is to reload all highlight categories. Highlights with 
selected categories can be reloaded via the Categories dropdown box. If metadata is stored in the 
Authors field, file names are unchanged. 
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Above threshold detection bounding boxes are shown in white (by default) and below-threshold 
bounding boxes in blue (by default), with the confidence value in white if both of the View Detections 
menu options are checked as shown below: 

 

 
Figure 77 Above and Below Threshold Bounding Boxes (bottom) and Box Selection Options (top) 

The icon at the top left changes from a white to a red background if an over-threshold detection is 
present. If there is at least one detection below the lower limit of the specified range and no 
detections above it, the icon changes to orange as shown below. 

 
Figure 78 Image with at least one below-threshold detection 

If a JSON file is available which was not created by scanning the locally stored data, the locally stored 
data should mirror the structure of the data used to create the JSON file. For example if the JSON file 
contains an element as shown below, the locally stored data should use the same folder structure, 

with only the drive letter (D: ) changed.  
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After loading has completed, the option to reload the data is presented as shown below. 

 
Figure 79 Reload data after loading JSON file 

OK should be selected if detection metadata has been stored in the file name. A highlights-only filter 
can optionally be applied, with the highlight category selected. 
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Confidence Range 
This option set the upper and lower bounds for the maximum detected confidence level for any entity 
appearing the Megadetector output via the screen below. For the default model MegaDetector 5A 
used by EcoAssist, the only entities detected are animals, vehicles and people, but models can be built 
in EcoAssist to identify particular species. However, very large numbers of training images (10,000 per 
species) are required for reliable detection. 
 

 
Figure 80 Megadetector Confidence Range screen 

If the upper bound is set to the default value of 1.0, the value of the lower bound used determines the 
compromise made between false negative and false positive detections, and should be set after 
examination of the histogram of confidence levels. The default lower bound is 0.6. High values will 
tend to include only high confidence detections, but will result in false negative detections if animals 
do not have strong visual contrast with their surroundings, or if parts of them are occluded. This 
advice can be viewed via the Info button. 
 
An example of a false negative detection is shown below: 

 
Figure 81 Example of correct (left) and false negative (right) detection  

The two successive images (taken 7 secs apart) have maximum detection confidences of 0.82 and 0.46 
respectively, despite them being visually very similar. Using a lower confidence bound of 0.8, only the 
first will register as a detection. The confidence level setting trades off between precision and recall. A 
low confidence level bound will have fewer false negative detections but will include more false 
positive ones. Low confidence detections are usually false, but may not be. 
 
The nature of detections can be explored by setting the upper bound to a value of less than 1.0 and 
examining the images with maximum confidence values in this range, either by right-clicking on 
highlights or by copying all highlighted images to a new folder and examining them. 
 
After setting a confidence range, highlighted images can be copied to a separate folder and analysed 
separately. The smaller number of images allows more reliable human detection of animals and 
determination of their species.  
 
If different detection bounds are required after a run, these can be changed via the Confidence Range 
screen. 
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Histogram 
The histogram option shows the distribution of maximum confidence values over the set of images. 
The distribution is highly variable, as the examples below show: 

 

 

 
Figure 82 Confidence value histograms and count vs time profiles for 3 datasets. A confidence range of 0.85-1.0 is used to 
define highlights. 

The top dataset above is from a baited camera trap running for 7 days, where the bait did not attract 
any animals. The small number of animal detections come from animals crossing the camera scene. 
The count vs time profile shows fewer triggers at night but no sharp steps. There are a very large 
number of false triggering images which Megadetector interprets as containing animals but with low 
confidence. 
 
The middle dataset is from another baited trap running for 7 days which attracted a large number of 
animals, resulting in many high-confidence detections and large, sharp steps in the profile where 
animals move within the camera scene for periods of a few minutes.  
 
The lower dataset is from a non-baited trap running over a single day. The absence of steps indicates 
that animals did not spend long within the camera scene, but there were a significant number of high-
confidence detections of animals briefly present. 
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Showing the Histogram as a cumulative percentage plot allows selection of the appropriate confidence 
range values: 

 
Figure 83 Cumulative Percentage Histogram Plot 

The lower bound of the first category above 80% represents a reasonable compromise between false 
positive and false negative detections. In the example above this will be 0.9. 
 

Copy 
The Highlight Copy option images highlighted using Megadetector or other algorithms to a selected 
folder. If the Changes algorithm is used, only images which differ from their predecessor will be copied 
and these may not include all those showing animals. The default destination folder is a sub-folder 
with the name Highlighted in the user’s Pictures folder. This folder is created if it does not already 
exist, and cleared of any existing content if it does. The highlight path is added to that of the selected 
folder, with the drive information removed.  
 
An option to load the content into CamTrap Pro is presented to facilitate visual inspection and tagging.  
In the case where false triggerings dominate animal detections, analysing the content of this folder 
will reduce the effort of identifying animal species in images. The confidence range lower limit can be 
adjusted to ensure that all animals are detected in images. 

Zoom 
Menu options are listed below 

Camera (ctrl-M) 
The Camera screen is below: 

 
Figure 84 Camera zoom selection screen 

The camera combo box lists all cameras in the loaded folder. Clicking OK sets the zoom region to 
include all images from the selected camera, plus a percentage margin specified in the Margin % 
combo box. This menu option is only shown if the folder sorted order is Folder->Modified. 

Unzoom (ctrl-U) 
This menu option undoes the last zoom operation. The keyboard shortcut is ctrl-U. 

Show All (ctrl-A) 
This menu option shows images from all cameras. The keyboard shortcut is ctrl-A. 
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View 

Refresh Points 
Clicking this menu options refreshes all points shown on chart according to the settings shown on 
page 49 when the Count vs Time chart was shown 

Summarising Tags 
A text and graphic summaries of tag data can be obtained via the Analysis-> Summarise Tags menu 
option. If no Tag Occurrence data is present in the tag database (which is stored in above the folder 
containing the images as TagDB_EpochName_CameraName_.vdb5), an option to create the tag 
summary will be presented as shown below.  

 
Figure 85 Screen for creating Tag Summary if none present 

Yes should be selected unless a tag summary has been generated before and the tags are unchanged. 
No closes the dialog. If Tag Summary data already exists, the screen below is shown instead of the 
screen as shown above: 

 
If Yes is selected from Figure 85, or the Rebuild option from screen above present, the option to 
detect and summarise tags one of two ways is then presented. Clicking View shows the summary as it 
appears in Figure 86. 

 
If only a few files have been tagged manually, selecting Yes will greatly speed creation of the tag 
summary and this option should generally be selected. No should be selected if files have been tagged 
externally (for example by Exif Pro or directly from Windows). The progress screen for this operation 
will move at an irregular speed. 
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Tag summary screens for Week, Day and All times groupings of data are shown below.  

  
 

 
Figure 86 Tag Summary Screens grouped by week (top left ), day (top right) and all times (bottom) 

The All grouping option adds all the detections which occur for each camera. If this option is selected, 
Modified dates do not have to be accurate for all the camera data. 
 
The Map button shows the summary as a map, with detections counts summed over all times. Map 
functionality is described in more detail on page 70. 
 
The upper Tag Summary grid shows the sum of durations and image counts and the detection event 
count for each tag present for all the loaded files. A duration of zero indicates that the tag was only 
applied to a single isolated image. A detection event occurs when there is a sequence of one or more 
images where no pair of sequential images is separated by more than the time interval specified as 
Max Gap on the Advanced tab of the Options screen. The time interval commonly used is 10 minutes. 
Detection event count is used as a measure of species abundance.  
 
The lower Tag Occurrences grid shows the tag, duration, image count, camera name, image folder (the 
name of the folder in which the file was found), the epoch of image collection (as defined in Options-
>General) start date/time and start file name of each group of files tagged. Min Animals and Max 
Animals show the minimum and maximum number of animal detections in the images comprising the 
occurrence.  
 
The camera name is shown if multiple cameras are used. The content of each grid can be copied to the 
clipboard and pasted into a report. 
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If tracking of individual members of a species is required, distinctive tags can be applied (eg Goanna 1, 
Goanna 2). 

Copying Summary Data 
The Tag Summary data can be copied to the Clipboard and transformed into a form suitable for import 
into a GIS (Geographic Information System). 

Summary Views 
Count vs time, text and map summaries are shown below: 

  
Figure 87 Summary Views of Tagged Data 

Consolidating Summaries 
A project will usually collect images from multiple cameras over multiple epochs in a particular region, 
and will generally require a report on the animal species recorded by the cameras. As projects may 
record data over dozens of epochs from tens or hundreds of cameras, millions of images are 
frequently created. If the analysis and tagging process operates on data grouped by epoch, a tag 
summary (and associated database) will be created for each epoch. If the data is grouped by camera, 
the summary is as shown below: 

 
 
Figure 88 Tag Summaries from with camera location for all times 

If the day or week option set in the General tab of Options 
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Summaries or individual epochs can be consolidated via the File->Consolidate TagDBs menu option. 
The Browse button allows selection of a folder below which to search for .vdb5 files whose name 
starts with TagDB to consolidate. The Consolidate button performs the consolidation. The Copy button 
copies displayed data to the clipboard, and Cancel closes the screen. Columns can be sorted by clicking 
in the header. After selecting a folder and consolidating and with Consolidate Cameras is checked, 
Summary image counts and durations from all cameras are consolidated as shown below. This mode is 
useful for summarising animal detections over the region where cameras were placed. 
 

 
Figure 89 Consolidated Tag Summaries with Consolidated Camera data for All Times 
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Figure 90 Consolidated Tag Summaries from IndividuaL Cameras for All Times 

 
Figure 91 Consolidated Tag Summaries for Individual Cameras - Grouped by Week 

The grouping interval can be set to day, week or all via the controls in the Summary Grouping box. 
Camera Locations, Project and Site name can be set via the Project Details button 
Clicking Map shows a map of camera locations with different icons for the number of Detection Events 
for selected tags (irrespective of whether Consolidate Cameras is checked or not): 
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Figure 92 Map Display of Consolidated Data 

Map 
The Map button shows a map representation of data from the Tag Summary grid, summed over all 
times. 

 
Figure 93 Map Representation of Summary 

Camera locations are shown as symbols on map background, which can show terrain, a satellite view, 
or an urban style map. Different symbols are used for different values of Detection Event count for 
each camera. The Camera name, image count and duration (in minutes) can be displayed as text 
below the symbol. Displayed tags can be selected from the list displayed. These comprise those 
created or selected as Use in the Categories grid of the General tab of Options. Only cameras with 
tagged data can be displayed by selecting Containing Tags in the Camera Display box. The default is to 
display data from all cameras. Changes to the map style, or the tags selected for display are applied via 
the Refresh button. The colour of the annotations can be changed from the default of red via the 
Annotation Colour button. The display can be zoomed in or out and the size of the displayed region is 
shown above the scroll bar, together with the zoom factor, which is not continuous. 
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The entire image can be copied to the clipboard using the Copy button, and pasted into a report.  
 
The range values assigned to the various key icons can be set by clicking on the icon or the text below 
it to show the Event Count Values screen. 

Event Count Key Values 
 

 
Figure 94 Event Count Values screen showing default values 

The values for Detection Count corresponding to the 4 different icons shown on the Map at camera 
locations can be defined above. If values do not conform to the rules shown, an error describing the 
non-conformance is shown on clicking Save and the screen does not close. If the values do conform, 
the screen closes and the map display is refreshed with the new values. 
 
Sets of values (or ranges) for the 4 icons can be saved and restored using the Restore and Save 
buttons. The Default range is as shown above. This range cannot be changed. 
 
The Export button exports camera location and detection counts into a CSV file which can be loaded 
into a web-based GIS to give a map as shown below, to which other layers can be added if required. 

 
Figure 95 Display of Detection Counts in ArcSoft GIS 
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Detections 
 

Machine vision (AI or machine learning) image analysis algorithms may identify inanimate, stationary 
objects such as bait, rocks or vegetation as animals with high confidence as shown below. 
 

 

 
Figure 96 Examples of non-animal detections 

Such detections may be identified as their boundaries remain fairly constant over a number of images, 
which is seldom the case for animal detections. Such detections can be shown via the detections 
screen, which shows the number of images in which detection boxes with areas within the specified 
tolerance (selected from Area % Tolerance combo box) and width of median values occur within a 
region of the image. Low tolerance value show fewer detections, but may miss some inanimate 
objects as detection box size and width may vary between images. 
 
The number of regions defined on images is specified by the Size parameter, with a default value of 
20, giving 400 regions. Counts of detections found in regions are colour coded as a heat map, as well 
as being shown within the image region. Hovering over a cell shows the count and a variation score 
defined as the detection box area variation over the mean detection box area. High counts and low 
variation scores indicate a high probability of the detection being of a stationary (i.e. inanimate) 
object. 
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Figure 97 Detection location information using grid of 35x35 regions. Detections of inanimate objects are circled in red and 
those of stationary animals in yellow 

 
The heatmap used to colour regions is black (0)-blue-green-yellow-red-white, with white being the 
region with the highest count. Hovering over a cell shows the count and the proportionate area 
variation. Detections of inanimate objects (circled in red) often have counts much higher than those of 
neighbouring regions, whereas detections of animals which do not move much (circled in yellow) are 
typically broader. 
 
The Time vs Count plot for another data set are shown below: 

 
Figure 98 Count vs Time profile with Highlights 

This data set contains detections with confidence >0.4 for 733 of 3157 files. The Detections map is 
shown below: 
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Figure 99 Detections map showing only a few groups of files with similar area and location 

The detections map shows a few groups of files with similar areas and locations probably arising from 
detections of stationary, inanimate objects. Inspection of images containing these detections (by right-
clicking twice on a region and selecting Show Images with Detections) confirms that these are 
detections of rocks: 

 
Figure 100 Image containing 1st of 67 detections 

After deleting all detections with a count of more than 5 in a region, the Count vs Time profile is as 
shown below: 
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Figure 101 Count vs Time after deleting detections with count >5 in a region 

Although the number of images with detections has been reduced from 733 to 328, many detections 
of stationary objects remain, principally because the detection areas and widths vary by more than 
15%. 
 
Detections meeting the specified criteria can be examined by right clicking on the region and selecting 
Show Images. This loads the images containing the detections into the main screen, where they can be 
examined to see if the object detected is inanimate or not. Detections can then be deleted by right-
clicking and selecting Delete Detections. All detections in regions with counts exceeding a specified 
threshold can also be deleted via the Delete button. Deletions can be restored via the Restore button. 
Deletion of detections is most useful when analysis is fully automated using a refining classifier to 
detect animal species. If semi-automated analysis is used, sequences of images containing detections 
are inspected before tags are applied and inanimate object can be excluded at this point. 
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Licensing 
As downloaded, CamTrap Pro comes with a free Demo license which allows unrestricted operation for 
30 days after installation or until 25 tags or 5000 images have been applied, and a nag screen is shown 
each time CamTrap Pro is started. If these limits are insufficient, a permanent basic license allows 
loading of up to 20,000 images and application of up to 1,000,000 tags can be purchased. Other 
permanent licenses for loading up to 50,000 or unlimited images and application of 1,000,000 tags can 
also be purchased. All licenses are available for purchase from here. Fixed-term licenses can be 
obtained at a reduced unit cost. Contact Aleka Consulting for a quote 
 
License key installation is done by clicking on the License top-level menu to show the following screen:  

 
Figure 102 Licensing screen after basic license purchase 

The screen shows License OK at the bottom left of the screen if the license is valid and indicates the 
license type. If the license is not OK, the reason is shown. The screen also provides a link to purchase a 
permanent license from the Aleka Consulting web site via PayPal by clicking the Buy License button. A 
license may be used on up to 2 computers.  

Support 
Clicking Help->Support and then the Create Support Data Zip File button creates a support zip file with 
data about the current instance of CamTrap Pro. Answer Yes to any prompts asking if you want to 
allow Registry Editor to make changes to the device. If the support zip file is then emailed to 
support@alekaconsulting.com.au this will provide valuable information for dealing with operational 
problems and bugs. 

Appendix 1 - Auxiliary Programs 
A number of programs may be used in conjunction with CamTrap Pro as follows: 

Exif Pro 2.1 
Exif Pro is a mature, ex-commercial product intended for photographers which allows the addition of 
multiple Windows tags to photos. After selecting the folder containing the images, selecting a group of 
thumbnails below the main image and right-clicking allows tags to be added or deleted as shown 
below. 
 

https://captionpro.com.au:444/AlekaConsulting/index.php/caption-pro-desktop-license-1-year/
mailto:info@alekaconsulting.com.au
mailto:support@alekaconsulting.com.au
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Figure 103 Exif Pro 

Tags can be defined via the  button at the lower left. Tagged files can be loaded into CamTrap Pro 

for further analysis in the same way as if the tags had been created in CamTrap Pro. 
 
Exif Pro 2.1 can be downloaded from a number of software libraries including CNet and Softonic. 
Source code is available at https://github.com/mikekov/ExifPro. 
 
 
 

  

https://github.com/mikekov/ExifPro
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EcoAssist 
EcoAssist is a Python application which can run on any platform (including Windows) from 
Netherlands ecologist and data scientist Peter van Lunteren. It requires the use of the Anaconda 
Python data science distribution (download a light version for Windows from here), and Git for 
Windows. These must be installed before attempting to install EcoAssist. Installation error messages 
are difficult to understand unless you have substantial knowledge of Windows. EcoAssist uses the 
Megadetector computer vision model. EcoAssist is best run on a machine with an Nvidia Graphics 
Processing Unit (GPU). It will run if this is not present, but much more slowly.  
 
EcoAssist is installed via an install.bat file, which may take over an hour to run. As it is downloaded 
from another computer it raises a Windows warning about harming your computer when run unless it 
is unblocked via the Properties tab. Once it is installed, a command window appears immediately, but 
the application screen (as shown below) takes some time to appear.  

 
Figure 104 EcoAssist Start Screen (Simple Mode) 

 
Click ‘To Advanced Mode’ and select the folder containing the images to show the screen as below: 

 
 
Figure 105 EcoAssist Advanced Mode screen 

The default checkpoint frequency of 500 should be used so that processing can be resumed in the 
event of a crash. Checking ‘Use custom image size’ and reducing the image size from the default value 
of 1280 increases processing speed at the cost of failing to detect small animal images. Using a value 
of 640 increases speed by a factor of 4. 

https://github.com/PetervanLunteren/EcoAssist
https://github.com/conda-forge/miniforge#miniforge3
https://gitforwindows.org/
https://gitforwindows.org/
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The default model (MegaDetector 5A) detects only animals, people and vehicles. It does not attempt 
to detect animal species. Process all images in the folder specified should be checked, and Deploy 
Model clicked. Once it is running a progress screen appears: 

 
Figure 106 EcoAssist progress screen 

Once processing is finished, a large tick is shown in the Analysis box: 

 
Figure 107 EcoAssist screen after completion of processing 

The output JSON file is created in the analysis folder with the name Image_recognition_file.json. The 
file contains data on the file name and details of the detections. It has the format as shown below: 

  
Figure 108 EcoAssist result file format (left) and a file node in the images node (right). 

This file should be browsed for when loading data into CamTrap Pro via the Highlight->Megadetector-
>Load JSON file option. 
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Refining Megadetector Results 
EcoAssist v 5.2 introduced the option to refine Megadetector results using pre-built species-specific 
classifiers to identify animal species. These are run after Megadetector and can be selected in Simple 
and Advanced mode as shown below: 

  
Figure 109 Simple (Left) and Advanced (Right) EcoAssist Modes Showing Refinement Options 

Species to be detected can be selected from those specified in the model, and the threshold for 
species classification and detection can be set in advanced mode. When a refining classifier is used 
with EcoAssist , two JSON files are produced. The file ‘image_recognition_file.json’ should be selected. 
An example of the format of the JSON file in this case is as shown below: 
 

 
Figure 110 Example of JSON file Element, Detection_categories and Classification_categories Nodes Using Refinement 

The refining classifier is only used when a Megadetector animal detection confidence exceeds the 
detection threshold specified in Figure 109. The confidence value for classification threshold for all the 
different custom classes (identified by category numbers) is then shown in the 
classification_categories node in descending order of confidence. If the classification confidence 
exceeds the threshold defined in in Figure 109 (Advanced mode) , the category number in the 
detection_categories node corresponding to the category shown in the classification_categories node. 
Refining classifiers are seldom highly accurate, as they have generally been built with much smaller 
numbers of training images than Megadetector. 
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Appendix 2 – Megadetector JSON File Format 
The JSON file from EcoAssist has the format as shown below where only Megadetector is used (no 
refinement): 

 
Figure 111 JSON File Format 

Parameters are as follows: 

Parameter Description Example 

path Full path to file with \ escaped C:\\users\\simon\\pictures\\Test\\001.jpg 

x Integer code for category of detection. 
Megadetector uses 1 for animal, 2 for 
human, 3 for vehicle 

1 

c Confidence value for detection (0 to 1.0) 0.954 

x X co-ordinate of top LH corner of 
detection bounding box as fraction of 
image width 

0.64 

y Y co-ordinate of top LH corner of 
detection bounding box as fraction of 
image height 

0.754 

width Width of detection bounding box as a 
fraction of image width 

0.13 

height Height of detection bounding box as a 
fraction of image height 

0.57 

 
If there are no detections or a detection is to be skipped, m is zero (or negative) and the file entry is as 
below 

 
The detection_parameters node contains the category code (an integer) and the category name. 
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Appendix 3 – Recommended Processing Sequence 
 
The first step is to examine the folder structure containing the all the camera trap images via the 
Folder Tree button on Pre/Post Process screen accessed via File->Pre/Post Process. This displays the 
folder structure below the selected folder and indicates if JPEG files are present in any of the folders. 
The structure should conform that shown in Folder Tree. Camera folders should be renamed appear in 
alphabetical order – this may require adding leading zeros before numbers appearing in folder names. 
Epoch folders (if present) should be treated in the same way 

Processing via Visual Inspection 
The simplest way to process camera trap data is to display all images for the selected data as a 
slideshow, stop when an image containing an animal of interest is shown and record the species of 
animal shown. Human vision is extremely good at identifying animals in images, but the number of 
images which can be examined is limited by fatigue. If the selected data contains a high proportion of 
images not containing any animals, fatigue effects will reduce the number of animal-containing images 
identified. As typical data sets may use dozens of cameras, recording over time periods of a month or 
more, data sets may comprise millions of images, making human inspection of all of them a daunting 
proposition. 
 
Once one or more animals have been detected in an image, its species (and possibly the animal’s 
identity) can be determined and the image tagged or a separate record made of the occurrence of that 
species or species/identity. If the time at which the image was taken is correctly recorded in image 
metadata, the Tag Summary option can be used to generate a report. The process for making the 
image Modified date to indicate the correct time of image capture is described in  
 
Playing a slideshow of images after Highlights Only filtering (perhaps after using a refining classifier) 
allows visual detection of images showing a species of interest. If one is detected the slideshow can be 
stopped (via ctrl-P) and the Count vs Time Plot zoomed to show only those images, which can then be 
tagged. Using Highlights Only filtering reduces the number of images to be inspected and the 
detection boxes focus attention.  
Setting Modified Dates. 

Reducing Image Count 
Camera traps may be configured to take a number of images in rapid succession after being triggered. 
These images may assist in species identification, but increase the number of images to be processed. 
If machine vision is being used to detect animals, the additional images may be redundant and can be 
filtered out in Options to reduce processing times. Removal of closely-spaced images will not affect 
detection event count, which is the ecologically significant measure most often used. Input images can 
also be decimated to achieve a similar result, although this will miss single-image detections. However, 
if animals detected are fast-moving (such as kangaroos), they may only be detected in a single 
member of a sequence, and if these detections are of interest, filtering may exclude significant data. 
 
Automated methods of detecting images containing animals using machine vision are readily available. 
One the best known uses a machine vision model called Megadetector, whose development and 
support is funded by Microsoft. This model can detect images containing people, vehicles, and 
animals. This model has been incorporated into a number of free, open-source analysis products 
including EcoAssist and CamTrap Detector. These products can be used to create a JSON file listing 
detections in images, and to sort image according to whether they contain any of the recognised 
entities on the basis of a threshold confidence score assigned to all detections. There is an inverse 
relationship between the threshold confidence score and the number of false positive detections.  
 

https://github.com/agentmorris/MegaDetector
https://addaxdatascience.com/ecoassist/
https://camtrap.net/detector
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Running CamTrap Pro on all images in which Megadetector has detected animals with a confidence 
above a threshold value can greatly reduce the number of images to be inspected, but at the cost of 
false negative detections, which may occur if a species of interest is highly camouflaged and false 
positive detections from inanimate objects. The false positive count can be reduced via the Detections 
screen, which can remove detections occurring in the same location (see Detections). Access to a 
computer with an Nvidia GPU is also required to process large image collections within a reasonable 
time using an analysis product. CamTrap Pro can operate on JSON files recording detections from 
analysis, making it possible for people without GPU-enabled computers to analyse data. This makes 
CamTrap Pro particularly suited to Citizen Science projects. 
 
Changing the threshold confidence value will trade off precision and recall for detections, and the 
optimum value may be different for different species. CamTrap Pro can generate a histogram of 
confidence values which can then be used to determine the optimum value for the confidence 
threshold. Using the Below Threshold Only filter allows examination of all images where there has 
been a detection, but with a confidence below the lower bound of the confidence range. If animals of 
interest are detected, the lower limit should be reduced. Once highlights have been generated in this 
way, only the highlighted images can be displayed via Options filtering.  
 
Playing a slideshow of images after Highlights Only filtering (perhaps after using a refining classifier) 
allows visual detection of images showing a species of interest. If one is detected the slideshow can be 
stopped (via ctrl-P) and the Count vs Time Plot zoomed to show only those images, which can then be 
tagged. Using Highlights Only filtering reduces the number of images to be inspected and the 
detection boxes focus attention.  

Setting Modified Dates 
In order to use the Tag Summary facility of CamTrap Pro, the Modified dates of all images should be 
set to the actual dates and time on which they were recorded. This can be achieved as follows. The 
range of Modified dates for images from each camera should then be examined via the Camera Info 
button, and any images with inconsistent dates (such as those arising from camera date resetting after 
recording) can be deleted via the Edit By Time button. If dates are consistent but incorrect (for 
example if they correspond to camera default dates, which may be years before the actual date on 
which the image was recorded), they can be shifted via the Change Modified Date options in the 
Options screen. If OCR is used to obtain image dates, about 10% of dates will not be reset due to 
failures of conversion of the dates shown at the top or bottom of the image. If different start dates are 
required for different epochs, these can be applied via the Use Epochs checkbox on the Option screen 
after setting Epoch start dates via the Set Epochs button. Dates may also be incorrectly set. For 
example, the wrong year may be specified. Modified dates may also be reset if the files are read by 
some other applications. In this this case, the duration of a camera data set may be zero or a few 
minutes. In this case, the Modified date can be reset to the Date Taken in the Options screen, and 
then changed if necessary. Filtering by decimation may speed the evaluation of time data for large 
data sets. 

Checking for Corrupt Files 
The presence of corrupt image files can cause CamTrap Pro to crash. They can be identified via the 
Check for Corrupt file option on the Pre/Post Process screen, and optionally deleted. After opening the 
folder below which are the desired images either one or two levels below (as specified in the 
Parent/Grandparent options) , the first image is displayed as below: 
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Figure 112 Display after loading camera data 

Analysis Methods 
An overview of the loaded data can be displayed via Analysis->Count vs Time. If the Modified dates of 
the loaded files do not reflect the actual dates on which the photos were taken, they can be set via the 
Options screen by various methods.  
 
The time profiles may give a rapid indication of whether the camera was triggered by animals or not if 
a baited tarp is used. False triggerings occur when the infrared radiation from one half of the image 
differs from that from the other. This can arise from moving vegetation or shadow patterns as well as 
the appearance or movement of an animal or bird. False triggerings are less frequent at night as 
shown in the examples below: 

  
Figure 113 Examples of data with many non-animal triggerings 
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Figure 114 Examples of data with few non-animal triggerings 

Where the majority of detections are of animals, clicking on a step in the count vs time profile is often 
sufficient to show the animal and allow tagging of image with the name of the animal appearing. 
Where this is not the case, CamTrap Pro provides three methods of automatically detecting images 
containing animals. 

Sequences 
This option highlights groups of images where a specified number of images occur within a specified 
time period as described on page 54. It exploits that fact that animals will move often rapidly around a 
baited trap, creating a large number of images over a short time period. Processing is very fast, and 
various combinations of image count and time period can be specified, but the process is not highly 
effective in discriminating between false and animal triggerings. Animal appearances may be very brief 
with non-baited traps and sequence analysis may miss these, as they do not produce a step. 

Changes 
This option resamples the input image to a specified size and looks for changes in hue and/or 
luminance over a number of pixels between adjacent images or the current image and an average of a 
number of previous images as specified on page 55. The parameter space is extremely large and 
processing is slow, but there may be a substantial reduction in the number of images to be inspected 
visually. 

Machine Vision 
Machine Vision (or Machine Learning) is the most effective method of detecting images containing 
animals but requires the data to have been processed to generate a JSON file using a classifier built 
from a training set of labelled images. The Megadetector public-domain classifier (or model) has been 
trained on 2.5 million images but only detects animals, humans and vehicles. It is readily available and 
is built into a number of applications, including EcoAssist but requires a computer with an Nvidia GPU 
for fast processing. A gaming computer with an Nvidia GeForce 3060 8 Gb graphics card processed 12 
MPixel images at a speed of 4-5 images per second. On a non-GPU 2.3 GHz machine, speed was about 
7 seconds per image. EcoAssist also provides a number of species- specific classifiers which can be 
used to refine the animal category of Megadetector to identify particular species. 
 
Using Megadetector to highlight images containing animals or birds with confidence > 0.5 for the data 
with many false triggerings shown in Figure 113 gives results as shown below. Highlighted images are 
shown in dark blue. 
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Figure 115 Data with many false triggerings analysed using Megadetector 

In the data shown in the left panel, Megadetector finds 89 out of 5149 images contain animals, which 
is greatly reduces the number of images which have to be visually inspected by zooming into the Time 
Analysis display and right-clicking on highlighted values. However, in the data shown in the right panel, 
Megadetector finds that 8554 out of 9524 images contain images or animals or birds, which is not a 
useful level of data reduction. Clicking on one of the highlighted images, indicates that Megadetector 
is detecting the bait as an animal 

 
Figure 116 Megadetector detecting bait as an animal 

Increasing the confidence threshold to 0.9 gives a greater reduction (to 322 images) and almost all of 
the highlighted images contain animals or birds. The highlighted images are all outside areas of rapid 
increase of count and were almost all taken at night. 

 

 
Figure 117 Example of night-time triggering 
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Tagging 
Where highlights have been created via machine learning or change detection, bounding boxes 
are shown around any detections. After visual identification of the animal species, text can be 
added to the box below the image, and clicking Apply will store the text as a tag in the image file 
metadata as shown below: 

 

 
Figure 118 Image with bounding box around detected animal 

Text from a set of options can also be added to the text box (and optionally applied) via the Presets 
screen shown on page 40.  

 

Zoom 
Menu options are listed below 

Camera (ctrl-M) 
The Camera screen is below: 

 
Figure 84 Camera zoom selection screen 

The camera combo box lists all cameras in the loaded folder. Clicking OK sets the zoom region to 
include all images from the selected camera, plus a percentage margin specified in the Margin % 
combo box. This menu option is only shown if the folder sorted order is Folder->Modified. 

Unzoom (ctrl-U) 
This menu option undoes the last zoom operation. The keyboard shortcut is ctrl-U. 
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Show All (ctrl-A) 
This menu option shows images from all cameras. The keyboard shortcut is ctrl-A. 

View 

Refresh Points 
Clicking this menu options refreshes all points shown on chart according to the settings shown on 
page 49 when the Count vs Time chart was shown 
Summarising Tags, the option Analysis->Summarise Tags should be selected. Tag data is stored in a 
separate database (Tag_<Epoch>_<CameraName>_.vdb5) created in the loaded folder. To consolidate 
tags from a multiple cameras or epochs, a folder should be selected above all the individual databases 
in the Consolidate Tags screen shown on page 67, and Consolidate clicked. 

Fully Automated Processing 
The availability of species-specific classifiers with acceptable performance makes fully automated 
processing a possibility, using the Name As Tag functionality described on page 20. Checking this 
option for categories displayed in the Options->General Tab automatically adds tags as well as 
highlights to files during processing of the JSON file from the classifier where the classification 
confidence falls within the range specified. Used in conjunction with the Map display, it is possible to 
create publicly usable results from a large survey involving dozens of cameras and hundreds of 
thousands of images in a single step. However, processing times may be several days and the following 
conditions apply: 
 

1. All camera folders must be at the same level in the folder tree. 
2. Camera folder names should be less than 10 characters long to avoid overlapping on the Map 

display. 

Accuracy 
Machine vision algorithms rely on similarity between images used for training and those being 
analysed. However, image comparison features are not the same as those used by humans and 
misleading results may be obtained. This can lead to incorrect identification as shown below: 

 
 
Figure 119 Misidentified Animal 

Inanimate objects such as rocks or vegetation may also be detected as animals as shown below. 
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Figure 120 Detection of rocks and vegetation as animals 

If a pre-trained classifier based on species found in location distant from the images being analysed 
and not found in the analysis location is used, poor results may be obtained. For example, a classifier 
based on South African veldt wildlife (mainly large mammals) will not give sensible results when 
applied to Australian images – animals are detected as being in incorrect categories rather than being 
undetected. 
 
Setting lower threshold confidence values allow a trade-off between precision and recall, but high 
confidence spurious detections may still occur. Highly camouflaged animals may only be detected with 
a very low confidence and using this value may result in a massive number of false positive detections. 
Such images are not suited to automated processing. 
 

  
Figure 121 High-confidence spurious detection (left) and low-confidence detection of camouflaged lizard (right) 

Photos recorded at night may have a much lower resolution than those recorded in daylight and this 
may affect detection accuracy. Classifiers may work well for some categories but poorly for others. 
Accurate and complete classification may not be critical for assessment of common, frequently 
detected species, but if the species of interest is rare or highly camouflaged, fully automated 
processing may not be appropriate. Fully automated species analysis will never achieve the accuracy 
of manual refinement of generic classifier results, but has the substantial advantage of requiring little 
human input.  
  


